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1 An overview of ELPLA-Graphic 

 

ELPLA-Graphic is used to display graphically the calculated results and input project data. The 

drawing of the results and data can be displayed first on the screen, and then can be sent to the 

printer or plotter. The calculated results and input project data can be presented graphically as 

follows: 

 

- Results in isometric view 

- Results as contour lines 

- Result values in the plan 

- Distribution curves of results in the plan 

- Results as circular diagrams 

- Deformation 

- Principal moments as streaks 

- Support reactions as arrows 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Principal soil stresses as streaks 

- Principal soil strains as streaks 

- Data in isometric view 

- Data in the plan 

- Boring locations 

- Boring logs/ Limit depth 

- Punching shear 

- Beam results 

 

The drawings, if desired, can be saved as WMF-format files, in which they can be exported to 

other Windows applications to prepare reports, slide presentations or add further information. 

 

 

2 Description of ELPLA-Graphic 

 

ELPLA-Graphic is a 32-bit, graphical software product that operates under Microsoft Windows 

9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows applications makes it 

easy to learn how to use ELPLA-Graphic, especially if you are already familiar with the 

Windows environment. The program package ELPLA consists of 7 separate programs. These 

programs can run independently. The name and short description of the seven separate programs 

are given in Table E-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  
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Table E-1 Names and descriptions of the 7 separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

In order to use ELPLA-Graphic, first the user must define the project data by ELPLA-Data, and 

then must analyze the problem by ELPLA-Solver. Table E-2 gives a list of files, which are read 

or created by ELPLA-Graphic. The files can be classified in four groups. 

Table E-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Graphic files (*.GRA)              ELPLA-Graphic 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table E-3 shows the filenames, contents and groups of all files that may be read or 

created by ELPLA-Graphic. 

Table E-3 Names and contents of files 

 

A Main data files 

Filename    Contents  

FIRMA    Firm header 

STEU                        Default directory for files that are saved by ELPLA 

NOFORMAT             Number formats  

UNITS     System of units 

 

B Graphic files 

Filename           Contents 

LINEFORM.GRA        Line formats 

FONT.GRA                                     Font data 

LEGENDE.GRA                         Legend data 

PAINT.GRA                          Fill color data 

PLOTPAR.GRA                         Plot parameters 

NODISPLA.GRA                             Data of display values 

ORDINATE.GRA                            Max. ordinate data 
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C Project data files 

Filename  Contents 

*. AUF        3 lines text to identify the project 

* .PO1          System data (calculation method-isolated slab) 

* .PO2          System data (calculation method-system of slabs) 

*. P23         Reinforcement data 

*. P33        Data of supports/ boundary conditions 

*. P35       Data of spring supports 

*. P81       Data of spring supports for plane frame 

*. P91       Data of spring supports for plane stress 

*. P61        Data of supports/ boundary conditions for plane frame 

*. P71        Data of supports/ boundary conditions for plane stress 

*. P31        Data of supports/ boundary conditions for slab and grid 

* .BAU               Soil data 

*. PC1                         Load data  

*. PCF         Load data for plane frame 

*. PCW        Load data for plane stress 

*. PL6              FE-Net data 

*. PL4    Area around nodes 

*. GL1       Girder data  

*. P21               Data of material/ slab thickness/ levels/ coordinates 

*. P41                          File of boring fields 

*. PP1                          File of external foundations 

*. PV1       Data of additional soil settlements 

*. DSS      FE-Net in z-direction 

*. PIL       Pile properties 
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D Final result files 

Filename  Contents 

*. GH1       Internal forces of girders 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. QUN      Ultimate bearing capacities at nodes (qul) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab  (Asx1) 

*. H14      Reinforcement of the slab  (Asx2) 

*. H15      Reinforcement of the slab  (Asy1) 

*. H16      Reinforcement of the slab  (Asy2) 

*.U_X      X-Displacements in soil (u)             

*.V_Y      Y-Displacements in soil (v)           

*.W_Z      Z-Displacements in soil (w=s)          

*.S_X      X-Stresses in soil (σx) 

*.S_Y      Y-Stresses in soil (σy) 

*.S_Z      Z-Stresses in soil (σz)            

*.TXY      XY-Shear stresses in soil (τxy)  

*.TXZ      XZ-Shear stresses in soil (τxz) 

*.TYZ      YZ-Shear stresses in soil (τyz) 

*.VAX      X-Strains in soil (εx) 

*.VAY      Y-Strains in soil (εy) 

*.VAZ                        Z-Strains in soil (εz) 

*.VXY      XY-Shear strains in soil (γxy) 

*.VXZ      XZ-Shear strains in soil (γxz)            

*.VYZ      YZ-Shear strains in soil (γyz) 

*. PPU      Punching results 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-Graphic command. 

 

 

3 Starting ELPLA-Graphic 

 

Start ELPLA-Graphic by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure E-1) appears.  
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Figure E-1 Introduction screen of ELPLA-Graphic 

 

The menu head of Figure E-1 contains the following seven commands: 

 

- File 

- View 

- Graphic 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, other sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 

 

 

4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Make WMF-File 

- Send to ELPLA-Section 

- Print 

- Page setup 

- Files 1, 2, 3, 4 

- Exit 
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4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure E-2 shows "Open" Dialog box used to open a specified project.  

 

ELPLA is used to analyze not only isolated slab foundation but also system of rafts. Therefore 

the program can read two types of file names. One has the extension of PO1, which represents 

the isolated raft and the other has the extension of PO2, which represents the system of rafts. 

 

 
Figure E-2 "Open project" Dialog box 

 

4.2 File Menu–"Make WMF-File" command 

 

The drawing can be saved in a format that can be read by other programs. This feature allows 

you to include your drawing in reports and presentations and to enhance the drawing using other 

drawing or CAD software packages. The drawing can be exported in the Windows Metafile 

format (WMF). Figure E-3 shows "Save as" Dialog box used to export the drawing with the 

filename you wish to give the exported file, including extension and the directory in which to 

save the file. 

 

 
Figure E-3 "Save as" Dialog box 

 

4.3 File Menu–"Send to ELPLA-Section" command 

 

By "Send to ELPLA-Section" command it is possible, to define a diagram in ELPLA-Graphic by 

Mouse and end it to ELPLA-Section, Figure E-4. 
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Figure E-4 Defining a diagram in ELPLA-Graphic 

 

4.4 File Menu–"Print" command 

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure E-5 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box, Figure E-5.  

 

 
Figure E-5 "Print" Dialog box 
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4.5 File Menu–"Page setup" command  

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size, and paper source, as well as other printing 

options. Figure E-6 shows "Page setup" Dialog box. 

 

 
Figure E-6 "Page setup" Dialog box 

 

4.6 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

 

4.7 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Graphic is quitted, Figure E-7. 

 

 
Figure E-7 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 
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5.1 View Menu–"Status bar" command 

 

The status bar displays information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

Tool bars located just below the menu head are displayed with icons of program menus. 

 

 

6 Graphic Menu 

 

The graphic menu is the main menu, used to display the specified drawing with the setting given 

by options, format and window menus. The Graphic Menu commands are: 

 

- Results in isometric view 

- Results as contour lines 

- Result values in the plan 

- Distribution curves of results in the plan 

- Results as circular diagrams 

- Deformation 

- Principal moments as streaks 

- Support reactions as arrows 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Principal soil stresses as streaks 

- Principal soil strains as streaks 

- Data in isometric view 

- Data in the plan 

- Boring locations 

- Boring logs/ Limit depth 

- Punching shear 

- Beam results 

 

6.1 Graphic Menu–"Results in isometric view" command  

 

Calculated results can be displayed on the screen and plotted in isometric shape. In the Dialog 

box of Figure E-8 select an item to draw and click "OK". Figure E-9 shows the contact pressures 

in isometric view. 

 
Figure E-8 "Results in isometric view" items 
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Figure E-9 Contact pressures in isometric view 

 

6.2 Graphic Menu–"Results as contour lines" 

 

By this command the calculated results can be contoured and shaded to reflect the variation of 

results. When "Results as contour lines" command is chosen, the selection Dialog box shown in 

Figure E-10 appears. In this dialog box select an item to draw and then click "OK" Button.  

 

 
Figure E-10 "Results as contour lines" items 

 

Contours with a constant interval 

Contours can be displayed with a constant interval by checking "Contours with a constant 

interval" check box in "Plot parameters" form, Figure E-11. For drawing the contours, the 

minimum and maximum contour values, and also the contour interval are required. As an 

example, Figure E-12 shows the settlements as contours with a constant interval. 
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Figure E-11 "Contour lines parameters" Dialog box 

 

 
Figure E-12 Settlements as contour lines with a constant interval  

 

Contours with a variable interval 

Contours can be displayed with a variable interval by making "Contours with a constant interval" 

check box unchecked in "plot parameters" form, Figure E-41. For drawing the contour lines with 

a variable interval, the contour values are required to define in the form "Contour lines", Figure 

E-13. 
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Figure E-13 "Contours with a variable interval" Dialog box 

 

Color contours 

Contours can be colored and shaded by checking "Color contours" check box in "Plot 

parameters" form, Figure E-41. The number of shaded colors is 13, start at color blue, which 

represents the minimum value and end at color red, which represents the maximum value. The 

lines between shaded contours will be displayed, if "Display lines" check box in "Plot 

parameters" form is checked. As an example, Figure E-14 shows the settlements in color 

contours. 

 

 
Figure E-14 Color contours for settlements 

 

6.3 Graphic Menu–"Result values in the plan" command 

 

The calculated results can be tabulated on the mesh. When this command is chosen, the selection 

Dialog box shown in Figure E-15 appears. Select an item to draw and then click "OK" Button. 

As an example, Figure E-16 shows the values of top reinforcement in x-direction on the mesh. 
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Figure E-15 "Result values in the plan" items 

 

 
Figure E-16 Tabulation of the top reinforcement in x-direction on the mesh 

 

6.4 Graphic Menu–"Distribution curves of results in the plan" command 

 

By "Distribution curves of results in the plan" command the calculated results can be plotted as 

distribution curves on the mesh. When "Distribution curves of results in the plan" command is 

chosen, the selection Dialog box shown in Figure E-17 appears. In this Dialog box select an item 

to draw and then click "OK" Button. As an example, Figure E-18 shows the distribution curves 

of moment mx on the slab. 
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Figure E-17 "Distribution curves of results in the plan" items 

 

 
Figure E-18 Distribution curves of moment mx on the slab 

 

6.5 Graphic Menu–"Results as circular diagrams" command  

 

By this command the calculated results can be plotted as circular diagrams on the mesh. When 

"Results as circular diagrams" command is chosen, the selection Dialog box shown in Figure E-

19 appears. In this Dialog box select an item to draw, then click "OK" Button. As an example, 

Figure E-20 shows the circular diagrams for shear forces Qx. 

 

Color circles 

Circular diagrams can be colored and shaded by checking "Color circles" check box in "Plot 

parameters" form, Figure E-41.  
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Figure E-19 "Results as circular diagrams" items 

 

 
Figure E-20 Circular diagrams for shear forces Qx 

 

6.6 Graphic Menu–"Deformation" command 

 

By "Deformation" command the slab deformation can be displayed as a deformed mesh plot as 

shown in Figure E-21. 
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Figure E-21 Slab deformation 

 

6.7 Graphic Menu–"Principal moments as streaks" command 

 

By "Principal moments as streaks" command the principal moments hm1 and hm2 can be 

displayed as streaks as shown in Figure E-22. 

 

 
Figure E-22 Principal moments as streaks 
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6.8 Graphic Menu–"Support reactions as arrows" command 

 

By "Support reactions as arrows" command the support reactions V, Mx and My can be displayed 

in isometric shape as arrows. When this command is chosen, the selection Dialog box shown in 

Figure E-23 appears. In this Dialog box select an item to draw, then click "OK" Button. As an 

example, Figure E-24 shows the support reactions V as arrows. 

 

 
Figure E-23 "Support reactions as arrows" items 

 

 
Figure E-24 Support reactions V as arrows  

 

6.9 Graphic Menu–"Soil deformation as vectors" command  

 

By "Soil deformation as vectors" command the soil deformation can be displayed as vectors. 

When this command is chosen, the selection Dialog box shown in Figure E-25 appears. In this 

Dialog box select an item to draw, then click "OK" Button. As an example, Figure E-26 shows 

the soil deformation as vectors. 
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Figure E-25 "Soil deformation as vectors" items 

 

 
Figure E-26 Soil deformation as vectors 

 

6.10 Graphic Menu–"Soil deformation as deformed mesh" command  

 

By this command the soil deformation can be displayed as deformed mesh. As an example, 

Figure E-27 shows the soil deformation as deformed mesh. 
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Figure E-27 Soil deformation as deformed mesh 

 

6.11 Graphic Menu–"Principal soil stresses as streaks" command 

 

Here the principal soil stresses can be displayed as streaks. As an example, Figure E-28 shows 

the principal soil stresses as streaks. 

 

 
Figure E-28 Principal soil stresses as streaks 
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6.12 Graphic Menu–"Principal soil strains as streaks" command 

 

By this command the Principal soil strains can be displayed as streaks. As an example, Figure E-

29 shows the principal soil strains as streaks. 

 

 
Figure E-29 Principal soil strains as streaks 

 

6.13 Graphic Menu–"Data in isometric view" command 

 

By "Data in isometric view" command the input data can be displayed on the screen and plotted 

in isometric shape. When "Data in isometric view" command is chosen, the selection Dialog box 

shown in Figure E-30 appears. In this Dialog box select an item to draw, then click "OK" Button. 

As an example, Figure E-31 shows the loading in isometric view. 

 

 
Figure E-30 "Data in isometric view" items 
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Figure E-31 Loading in isometric view 

 

6.14 Graphic Menu–"Data in the plan" command 

 

By "Data in the plan" command the input data can be displayed in the plan view. When "Data in 

the plan" command is chosen, the selection Dialog box shown in Figure E-32 appears. In this 

Dialog box select an item to draw and click "OK" Button. As an example, Figure E-33 shows the 

loading in the plan. 

 

 
Figure E-32 "Data in the plane" items 
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Figure E-33 Loading in the plan 

 

6.15 Graphic Menu–"Boring locations" command 

 

By "Boring locations" command the boring locations in global coordinates can be displayed with 

the slab geometry as shown in Figure E-34.  

 

 
Figure E-34 Location of boring with zone types 
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6.16 Graphic Menu–"Boring logs/ Limit depth" command 

 

Here the boring logs (boring layers, soil material, water table and limit depth) can be displayed 

through ELPLA-Boring as shown in Figure E-35. The stress on soil under a specified point on 

the foundation with effective stress can be also displayed beside the corresponding boring log 

through ELPLA-Boring as shown in Figure E-36. The stress on soil is used to determine the limit 

depth of the soil layers. To get information about ELPLA-Boring, see the User’s Guide of 

ELPLA-Boring. 

 

 
Figure E-35 Boring logs with multi-layers with different soil material 
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Figure E-36 Limit depth of the soil layers 

 

6.17 Graphic Menu–"Beam results" command 

 

In ELPLA the finite element method was used to analyze both of the raft and girders, in which 

the raft was represented by plate bending elements while the girders were represented by grid 

elements. Furthermore, a combination between plate elements and grid elements may be used to 

represent ribbed rafts. If girders are considered in the project, "Beam results" command will 

appear in the graphic menu. 

 

"Beam results" command has the following options (commands): 

 

- Distribution of internal forces in the plan 

- Internal forces in isometric view  

 

"Distribution of internal forces in the plan"–Option 

This option displays the beam internal forces (torsion moments, bending moments and shear 

forces) with the slab geometry in the plan. The selection Dialog box shown in Figure E-37 

appears. In this Dialog box select an item to draw and click "OK" Button. As an example, Figure 

E-38 shows the distribution of bending moments in the plan. 

 

 
Figure E-37 "Distribution of internal forces in the plan" items 
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Figure E-38 Distribution of bending moments in the plan 

 

"Internal forces in isometric view"–Option 

This option displays the beam internal forces (torsion moments, bending moments and shear 

forces) with the slab geometry in isometric view. When "Distribution of internal forces isometric 

view"-Option is chosen, the selection Dialog box shown in Figure E-39 appears. In this Dialog 

box select an item to draw, then click "OK" Button. As an example, Figure E-40 shows the 

distribution of shear forces in isometric view. 

 

 
Figure E-39 "Distribution of internal forces in isometric view" items 
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Figure E-40 Distribution of shear forces in isometric view 

 

 

7 Options Menu 

 

The Options menu has the following commands: 

 

- Plot parameters 

- Display values 

- Scale 

- Set range 

- Axes 

- Title 

- Page No. 

- Copy 

- View grouping 

 

7.1 Options Menu–"Plot parameters" command 

 

Plot parameters may be set as default values by the program or be fully specified by the user. By 

"Plot parameters" command the following plot parameters can be specified (Figure E-41):   

 

- Display FE-Net, Axes, slab dimensions, FE-Net in separated elements, reference points         

and lines, axis arrows 

- Pages with or without a frame 

- Color element groups and slab thickness 

- Color section of punching shear 

- Color girders 
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- Draw girder thickness 

- Color circles of circular diagrams. If "color circles" is checked, the positive circles are red 

and the negative circles are blue 

- Color contours with or without display contour lines. If "color contours" is checked, the 

contours will have 13 constant intervals with 13 colors. Colors start at color blue, which 

represents the minimum value and end at color red representing the maximum value 

- Writing factor. If "Writing factor" is checked, the intensity of numbers on the contour 

lines will be defined 

- Display contours with a constant interval 

- Display boring subareas boundary 

- Color boring subareas 

- Mark boring subareas 

- Draw neighboring foundations 

- Draw block element 

- Draw element border 

- Color solid element 

- Display FE-Net in separated elements 

- Display reference points/ lines 

 

 

Figure E-41 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Display values" command 

 

By "Display values" command the values of the following items can be displayed, if desired, on 

the drawing (Figure E-42): 

 

- Loads 

- Boundary conditions 

- Spring supports 

- Element groups 

- Girder system 

- Piles 

- Internal forces of girders 

- Axes 
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- Support reactions as arrows 

- Slab thickness 

- Isometric views 

- Contour lines 

- Circular diagrams 

- Distribution curves of results 

- Soil deformation as vectors 

- Soil deformation as deformed mesh 

- Punching shear 

- Column types 

 

 
Figure E-42 "Display values" Dialog box 

 

7.3 Options Menu–"Scale" command 

 

By "Scale" command the scale factor of the drawing can be defined as shown in Figure E-43. 

The defaulted value for the scale factor is chosen to pass the active printer-paper format. By 

graphical drawing in the plan the scale is changed to scale factor, "scale factor" = "scale 1: ". 

 

 
Figure E-43 "Scale" Dialog box 

 

7.4 Options Menu–"Set range" command 

 

By "Set range" command the area of the slab, that will be drawn, can be defined. In the Dialog 

box shown in Figure E-44 define ranges, which bound this slab area. 
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Figure E-44 "Set range" Dialog box 

 

7.5 Options Menu–"Axes" command 

 

By "Axes" command scaled axes can be defined on the drawing, Figure E-45. 

 

 
Figure E-45 "Axes" Dialog box 

 

7.6 Options Menu–"Title" command 

 

By "Title" command the text data (two lines text above the drawing and two lines text under the 

drawing) can be defined, Figure E-46. 

 

Default texts are: 

 

- A-Title1: Method No. 

- A-Title2:      Name of method 

- U-Title1:      Name of drawing 

- U-Title2:      No. of nod columns and nod rows that define the drawing 
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Figure E-46 "Title" Dialog box 

 

7.7 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure E-47.  

 

 
Figure E-47 "Page No." Dialog box 

 

7.8 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to other Windows programs such as Word and AutoCAD, Figure E-48. 

 

 
Figure E-48 Drawing can be copied to other Windows programs 
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7.9 Options Menu–"View grouping" command 

 

Draw a group of data with results or a group of data together in one presentation (contour lines of 

settlements with loads and slab thickness, or loads with boring locations), Figure E-49. 

 

 
Figure E-49 Presentation of a group of data with results 

8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats  

- Fill color 

- Max. ordinate 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

By "Line formats" command the color, style and thickness of drawing lines can be defined, 

Figure E-50. The way a line is drawn depends on the setting of the color and style properties. 

There are available 15 different colors and 5 styles for line formats. The following list shows the 

available lines, which can be formatted: 

 

- Slab boundary 

- Elements 

- Isometric view 

- Distribution curves of results 

- Contour lines 
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- Legends 

- Circular diagrams 

- Arrows of support reactions 

- Page boundary 

- Identification box  

- Streaks of principal moments (+ve) 

- Streaks of principal moments (-ve)  

- Slab dimensions 

- Loads 

- Boundary conditions 

- Boring logs 

- Slab thickness 

- Axes of symmetry  

- Beam elements 

- Spring supports 

- Axes of symmetry 

- Symbol of symmetry 

- Vectors of soil deformation 

- Deformed mesh of soil deformation 

- Axis arrows 

- Girder axes 

- Piles in plan 

- Pile length 

- Pile hatching 

- Additional settlements 

- Reference points and lines 

- Columns 

- Cartesian grid 

- Punching shear 

- Borders of block elements 

 

 
Figure E-50 "Line formats" Dialog box 

 

8.2 Format Menu–"Fill color" command 

 

By "Fill color" command the fill color of drawing can be defined, Figure E-51. The following list 

shows the available items, which can be filled with a specified color: 
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- Loads 

- Boundary conditions 

- Springs 

- Zone type I: Bilinear interpolation 

- Zone type II: Linear interpolation 

- Zone type III: Node corresponds to boring 

- Circle of boring 

- Additional settlements 

- (+ve) Circular diagrams 

- (-ve) Circular diagrams 

- Punching shear 

- Material No. 

- Girder group No. 

- Sub area of boring No. 

- Pile group No. 

- Column group No. 

 

 
Figure E-51 "Fill color" Dialog box 

 

 

8.3 Format Menu–"Max. ordinate" command 

 

By "Max. ordinate" the max. ordinate, max. diameter, max. side, max. width and max. length for 

the drawing can be defined, Figure E-52. 

 

 
Figure E-52 "Max. ordinate" Dialog box 

 

8.4 Format Menu–"Font" command 

 

By "Font" command the font size (Figure E-53) and font type (Figure E-54) can be defined. 
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Figure E-53 "Font size" Dialog box 

 

 
Figure E-54 "Font type" Dialog box 

 

8.5 Format Menu–"Legend" command 

 

By this command the height and width of legends can be specified as shown in Figure E-55. 

Display legend 

In "Display legend" Group box check the legend that you wish to display. 

 

Legend size 

In "Legend size" Group box the height and width of the legend can be defined.  

 

 
Figure E-55 "Legend" Dialog box 

 

 

9 Window Menu 
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The Window menu has the following commands: 

 

- Zoom in 

- Zoom out  

- Zoom window  

- Zoom % 

- Original size 

- Viewing angle 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 

 

9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

When you choose "Zoom %" command, the following Dialog box in Figure E-56 appears. 

 

 
Figure E-56 "Zoom %" Dialog box 

 

By "Zoom %" command the size of drawing on the screen can be specified. Choosing "Zoom %" 

allows you to increase or decrease the size at which the drawing is displayed. Choosing 100% 

displays the drawing at its original size. Clicking on the percentage, changes the drawing size to 

the specified percentage. The drawing can be displayed at any size by typing the desired 

percentage in the specified Edit box. 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 

 

9.6 Window Menu–"Viewing angle" command 

 

The perspective drawing in a three dimensional view can be defined, Figure E-57. 
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The default viewing angle for isometric drawing, Figure E-58: 

 

Viewing angle about x-Axis  = 295 

Viewing angle about y-Axis  = 0 

Viewing angle about z-Axis  = 20 

 

The default viewing angle for drawing in the plans: 

 

Viewing angle about x-Axis  = 0 

Viewing angle about y-Axis  = 0 

Viewing angle about z-Axis  = 0 

 

 
Figure E-57 "Viewing angle" Dialog box 
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Figure E-58 Contour lines of settlements with viewing angles 295, 0, and 20 

about the x-, y-, and z-axes, respectively 

 

10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Graphic 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure E-59. 
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Figure E-59 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 

 

10.4 Help Menu–"About ELPLA-Graphic" command 

 

Clicking the command "About ELPLA-Graphic" displays the information form of ELPLA-

Graphic as shown in Figure E-60, which gives information about ELPLA-Graphic and the 

calculation method of the loaded project. 
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Figure E-60 Information form of program ELPLA-Graphic 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table E-4 to Table E-11: 

 

Table E-4 Shortcut keys of menu head 

Shortcut keys  Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+g]     "Graphic" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 

 

 

 

 

 

 



 

 

ELPLA-Graphic 

 

 

 E-43 

Table E-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [w]    "Make WMF-File" 

[Alt+f] then [s]    "Send to ELPLA-Section" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table E-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [g]    "Tool bars-Graphic" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 
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Table E-7 Shortcut keys of Graphic-Command  

Shortcut keys Action 

[Alt+g] then [r] Calling command  "Results in isometric view" 

[Alt+g] then [e]    "Results as contour lines" 

[Alt+g] then [v]    "Result values in the plan" 

[Alt+g] then [d]    "Distribution curves of results in the plan" 

[Alt+g] then [f]    "Deformation" 

[Alt+g] then [p]    "Principal moments as streaks" 

[Alt+g] then [s]    "Support reactions as arrows" 

[Alt+g] then [v]    "Soil deformation as vectors" 

[Alt+g] then [m]    "Soil deformation as deformed mesh" 

[Alt+g] then [s]    "Principal soil stresses as streaks" 

[Alt+g] then [p]    "Principal soil strains as streaks" 

[Alt+g] then [a]    "Data in isometric view" 

[Alt+g] then [n]    "Data in the plan" 

[Alt+g] then [b]    "Boring locations" 

[Alt+g] then [o]    "Boring logs/ Limit depth" 

[Alt+g] then [g]    "Beam results" 

 

Table E-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [d]     "Display values" 

[Alt+o] then [c]     "Scale"  

[Alt+o] then [s]     "Set range"  

[Alt+o] then [a]     "Axes" 

[Alt+o] then [t]     "Title"  

[Alt+o] then [p]     "Page No."  

[Alt+o] then [c]     "Copy" 

[Alt+o] then [v]     "View grouping" 
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Table E-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+t] then [i]     "Fill color"  

[Alt+t] then [x]     "Max. ordinate"  

[Alt+t] then [f]     "Font"  

[Alt+t] then [d]     "Legend" 

 

Table E-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out"  

[Alt+w] then [w]     "Zoom window"  

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 

[Alt+w] then [v]     "Viewing angle" 

 

Table E-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "New in ELPLA" 

[Alt+h] then [n]    "Short description of ELPLA" 

[Alt+h] then [a]     "About ELPLA-Graphic" 

 

11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position the user can obtain 

almost menus of the program. 

 

- By double-clicking on legend, firm header, title or project identification the 

corresponding menu appears 

- By double-clicking on scale in the identification box "Scale"-Menu appears 

- By double-clicking on file name in the identification box "Open"-Menu appears 

- By double-clicking on page No. in the identification box "Page No."-Menu appears 

- By clicking the right mouse Button at any position on the screen the user can also obtain 

the Popup-Options-Menu, Figure E-61 

- By double-clicking on a specified node on the FE-Net the corresponding node 

information appears, Figure E-62 
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Figure E-61 Menu "Popup-Options" 

 

 
Figure E-62 Node information 
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12 Samples for graphical drawings using ELPLA-Graphic 

 

ELPLA-Graphic gives the ability to present more than 100 different graphical drawings for data 

and results. In this paragraph some graphical drawings for data and results of example problems 

"gb7" (an irregular raft on irregular subsoil) and "rib" (a ribbed raft) are presented. 

 

The pages P1 to P10 show some graphical presentations of data and results for example problem 

"gb7", while pages P11 and P12 show the graphical presentation of girders for example problem 

"rib". 

 

12.1 Graphical drawings of data 

 

Data in isometric view   Loading    Page  P1 

 

Data in the plan    Geometry of slab with loading  P2 

      Location of borings    P3 

 

12.2 Graphical drawings of results 

 

Results in isometric view   Contact pressures q    P4 

 

Deformation     Deformation w    P5 

 

Results as contour lines   Settlements s     P6 

 

Result values in the plan   Bottom Rafts y-Direction Asy2  P7 

 

Distribution curves of results in the plan Moments my     P8 

 

Results as circular diagrams   Moments mx     P9 

 

Principal moments as streaks   Principal moments    P10 

 

Girders presentation in the plan  Beam-Bending moments Mb   P11 

 

Girders presentation in isometric view  Beam-Bending moments Mb   P12 
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13 Index 

A 

Axes ........................................................................ 29, 32 

B 

Boring locations ...................................................... 25, 44 

Boring logs ................................................................... 26 

C 

Color circles .................................................................. 17 

Color contours .............................................................. 15 

Contours with a constant interval ................................. 13 

Contours with a variable interval .................................. 14 

Copy ................................................................. 29, 33, 44 

D 

Data in isometric view ............................................ 23, 47 

Data in the plan ............................................................. 24 

Deformation .................................................................. 18 

Display FE-Net ............................................................. 29 

Display values ......................................................... 29, 30 

Distribution of internal forces in the plan ..................... 27 

Distribution of internal forces in isometric view .......... 28 

Distribution of results in the plan ................................. 16 

E 

Exit ........................................................................... 8, 11 

F 

File .................................................................................. 8 

File groups ...................................................................... 5 

Files 1, 2, 3, 4 ........................................................... 8, 11 

Fill color ................................................................. 35, 36 

Final result files .............................................................. 7 

Font ......................................................................... 35, 37 

Format ............................................................................. 8 

Format menu ................................................................. 35 

G 

Girders .................................................................... 27, 44 

Graphic ........................................................................... 8 

Graphic files.................................................................... 5 

Graphic Menu ............................................................... 12 

H 

Help ................................................................................ 8 

Help Menu .................................................................... 41 

I 

Internal forces in isometric view ................................... 28 

L 

Legend ..................................................................... 35, 37 

Limit depth .................................................................... 26 

Line formats ................................................................... 35 

M 

Main data files ................................................................. 5 

Make WMF-File .......................................................... 8, 9 

Max. ordinate........................................................... 35, 37 

Mouse ............................................................................ 45 

N 

New in ELPLA .............................................................. 41 

O 

Open ................................................................................ 8 

Options ............................................................................ 8 

Original size ............................................................ 38, 39 

P 

Page No. .................................................................. 29, 33 

Page setup .................................................................. 8, 11 

Plot parameters .............................................................. 29 

Principal moments as streaks ......................................... 19 

Print ........................................................................... 8, 10 

Project data files .............................................................. 6 

R 

Result values in the plan ................................................ 15 

Results as circular diagrams .......................................... 17 

Results as contour lines ................................................. 13 

Results in isometric view ............................................... 12 

S 

Scale ........................................................................ 29, 31 

Set range .................................................................. 29, 31 

Short description ..................................................... 41, 45 

Shortcut keys ................................................................. 42 

Status bar ....................................................................... 11 

Support reactions as arrows ........................................... 20 

T 

Tips and Tricks .............................................................. 42 

Title ......................................................................... 29, 32 

Tool bars .................................................................. 11, 12 

V 

View .......................................................................... 8, 11 

View grouping ......................................................... 29, 34 

Viewing angle .......................................................... 38, 39 
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W 

Window .......................................................................... 8 

WMF-File ....................................................................... 9 

Z 

Zoom % ......................................................................... 38 

Zoom in ......................................................................... 38 

Zoom out ....................................................................... 38 

Zoom window ................................................................ 38 

 


